What’s New in TK Solver 6.0
Changes to the Extension
TK6 Models should have the .TKWX extension to separate them from TK5 files. Wizards of the products
should work with their respective TK Solver versions and both TK5 and TK6 should be able to co-exist on
the same machine. [BUG NO: 151]
NOTE: please make sure that you manually change the extension of files already saved from TK Solver
6.0 with the older .tkw extension to .tkwx. Making this change will ensure that when you double click
on the model, it will automatically be loaded by the right version of TK Solver.

Changes to the User Interface
TK Solver 6.0 now sports two distinct interface types.



The tabbed sheet interface (which is the default)
The optional and traditional TK Solver 5.0 type interface

The new tabbed interface keeps the sheets and subsheets in a tab strip just under the toolbar (also
referred to as the ribbon bar). When you open subsheets, plots or tables they automatically get
appended to the tab strip. When the number of tabs exceeds the horizontal width of the client area a
scroll arrow (thumb) appears to the right and left of the tab strip as shown below. The arrows allow you
to scroll horizontally to the right or left in order to view sheets that may be hidden from view. You can
also switch from one sheet to the next using the keyboard Ctrl + F6 key combination.
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If you want to view 2 sheets or multiple sheets simultaneously, TK Solver 6.0 provides a facility to be
able to drag a tab and have it hosted in a new tab group adjacent to its parent tab group. To do this first
click on the tab title and continue to keep your left mouse button pressed. Now drag the tab down and
slightly away from its original position and release the left mouse button. The moment you do this, a
new tab group will get created and the dragged sheet will now find itself hosted in a new tab group.
Once a new tab group is created you can drag other tabs and drop them into the new tab group. The tab
groups are separated by a vertical splitter that can be dragged horizontally to resize the tab groups. TK
Solver 6.0 can host multiple tab groups and models can be save with their respective tab group settings.
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The properties pane on the right displays the properties of the currently selected object. While TK Solver
5.0 had this facility in the form or a pin-up properties window, TK Solver 6.0 shows the properties to you
in a more conventional dockable properties pane. You can close the properties window if you desire
more space to work with.
The Style dropdown combo box on the top right allows you to pick specific visual styles. The
recommended default for TK Solver 6.0 is the traditional Blue style.

The ‘View’ ribbon bar tab provides various controls to switch user interface elements on or off. These
setting stay active across multiple TK Solver sessions.
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The ‘Window’ drop down enables you to switch between the default tabbed view and the traditional (TK
Solver 5.0 style) tiled or cascaded view as shown below.

Every time you reset the TK Solver sheets by executing the File->New command, TK Solver will reset
itself back to the default tabbed layout. If you wish to retain the Traditional (tiled) layout across TK
Solver sessions, you can check the ‘Traditional Sheet Layout’ option in the Environment settings as
shown on the next page. Note that the way each TK Solver model is saved (either with a traditional
layout or the tabbed layout) overrides (takes priority over), this environment setting. This is done to
ensure that the model gets loaded with the appropriate sheet layout desired by the author or the
model. Once the model is loaded however, you can change the layout as you deem fit.
Note: Fonts are globally set in the Solver tab using the Environment button. This is
where you set the default font type, color and size.
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Font and Color Management
TK Solver 6.0 provides you with the facility to control the Font and the Color of each cell on every sheet
and sub sheet. You can select the region of the sheet whose font you would like to change and then pick
the appropriate font and color from the ‘Font’ command group located in the ‘Home’ tab of the ribbon
bar as shown below.

The row height of each sheet row automatically adjusts to fit the cell with the largest font on that row.
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Saving Model Scenarios
Often times TK models are created to be back solvable with different combinations of inputs and
outputs. When switching from one input-output combination to another, a user traditionally blanks out
some inputs to make them outputs and correspondingly switches the status of certain outputs to make
them inputs under a different scenario.
There are also situations when a specific TK model may have been designed to be used with specific
(named) sets of related inputs (or default inputs) as dictated by the application domain. Each input set
may signify a starting point for using the model under specific circumstances.
In such situations, it is very useful to be able save each scenario and recall it by simply selecting the
name of scenario. TK Solver 6.0 gives you the ability to save and subsequently reload each scenario by
simply selecting its name.
To summarize - a ‘Scenario’ is like a data set specific to a TK model. Every data set includes the following:
a. Variables to be displayed in the Variables sheet.
b. Input values given to the input variables displayed on the Variables sheet.
c. A specific (and unique) name given to this combination of inputs and outputs i.e. the data set.
Here is how you do this. Load a model into TK Solver. To illustrate the concept of scenarios we have
created a simple model with 5 rules to calculate various parameters of a cone.
volume = 1/3 * pi() * radius^2 * height
radius^2 + height^2 = slant^2 ; Pythagorean theorem
surface = pi() * radius * slant
tand(theta/2) = radius/height
diameter = 2* radius
The corresponding Variables Sheet of this model is shown on the next page. This model is back solvable
and we can have a few different scenarios:
a. We could input the ‘height’ and the ’radius’ of the cone and calculate its ‘volume, slant &
‘surface’ area.
b. OR we could input the desired ‘volume’ and ‘radius’ of the cone to compute what the ‘height’ of
the cone should be.
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In order to save these two scenarios we need first solve the model with the desired inputs for scenario
(a) described above and then bring up the ‘Manage Scenarios’ dialog as shown below.

Now click ‘Save As’ to bring up the following dialog.
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The Save Scenario dialog lists all the currently saved scenarios and their corresponding description
(summary). Since we don’t have saved scenarios yet, these lists appear blank. Now to save the current
scenario click Save As New. Enter the Scenario name as ‘Radius, Height Input – Volume Output’. Enter an
optional description and then click OK.

This completes the save operation for our first scenario. To check if our scenario has been saved you can
click Save As in the Manage Scenarios dialog once again. You will now see the saved scenario listed in
the dialog as shown below.

Now cancel out of the Manage Scenarios Dialog and let’s go back to the Variables Sheet to setup
another scenario i.e. scenario (b) we had described earlier. To do that we simply swap our inputs and
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outputs as shown below. We can now enter the ‘radius’ and ‘volume’ of the cone to calculate the
‘height’.

Repeat the above steps described to save scenario (a). We give this scenario a different meaningful
name ‘Radius, Volume Input – Height Output’ as shown below. Click OK to complete saving scenario (b).

Now to switch from one scenario to the other, bring up the Manage Scenarios dialog and then select the
scenario you would like to ‘Apply’ and then click Apply Scenario. That’s it. You will notice that your
Variables Sheet now reflects the set of inputs and outputs as defined in the selected scenario.
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You can similarly select other saved scenarios and switch between them very easily. The ‘Required’
column of the Manage Scenario dialog also allows you to control the visibility of specific variables for
each scenario. There may be instances when you feel that for a model that has numerous inputs and
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outputs, you may want to ‘hide’ certain outputs for specific input sets. This enables you to setup
scenarios that reduce variable sheet clutter and enable the user to focus on what he or she would like to
use the model for.
To delete a saved scenario select the scenario from the combo box in the Manage Scenarios dialog and
then click Delete Scenario. Note that you cannot delete a scenario that is currently applied to the
Variables Sheet. In such a case you have to first apply the ‘Default Scenario’ and then delete the
scenario you want to delete.
The Manage Scenario dialog also allows you to change default input values associated with a scenario
and then update what was previously saved.

Writing External Functions in C++
[Refer to other attachment for this - ‘Writing your own External Functions in C++.docx’]

Custom Applications Menu
The ‘My TK Solver Models’ folder provided by
default in the ‘Applications’ bar allows users to
create custom TK application hierarchies. As users
create TK solutions, it often becomes necessary to
categorize or classify these solutions into groups
or sub-groups. The ‘My TK Solver Models node
serves as the root node of such a custom
hierarchy of models.
Adding Groups
To add a group node, right click on the parent
node and select Add Group.

Enter the Title for the node. You can optionally associate a picture file with each node and also give it a
relevant description. Click OK to complete adding the new group to our custom hierarchy. The picture
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file will not be visible in the Navigation Bar hierarchy, but will be if the custom menu is launched using
the UTS Menuing System as shown below.

You can now add models to the group that we just created by clicking Add Model.
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This dialog is similar to the Add Group dialog, except that in this dialog you are also expected to provide
the file path to the TK model you would like to associate with this node. We are adding a model after all.
See the screen below.

Select the TK model you would like to associate with the new node and click OK.
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Clearing Guesses
The Solver tab in the toolbar now provides a facility to clear all guesses that my remain if a model does
not solve successfully. An explicit guess iterates to an ouput after a model has solved successfully.
However there are instances when a solution does not converge as expected and in such cases TK Solver
will leave those intermediate guess values in the input field of the guessed variables.

The Clear Guesses command helps clear all the guesses automatically without the need to blank out
guessed fields manually.

Choice List for Variables
A variable that requires its input value to come from predefined list of inputs, it can be associated with
a ‘Choice List’ as shown in the properties window below. In the example below, a list called MatName is
associated with the variable ‘Material’.
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The list ‘MatName’ can then be populated with the range of possible inputs. Variables with an
associated Choice List show up with a list icon in the corresponding row header column. When a user
double click on the input field for the variable, the list of possible choices is automatically displayed as
shown above.

Multiple X versus Multiple Y Line Charts
TK Solver 6.0 allows you to define multiple X versus multiple Y axes line charts. The line chart sub sheet
hosts two columns for the X axis and Y axis list names. Each row of the line chart sub sheet therefore
represents one set of x,y coordinates that define a single line. Leaving the X Axis field blank will cause TK
to ignore the corresponding line.

For purposes of illustration let’s assume we have lists x1, x2, y1, and y2 with the following values in
them:
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Let’s now define a line chart as shown below and plot it.

TK Solver combines the lists x1 and x2 and shows the combined X list values along the X Axis of the plot.
Note that because there is no data provided between the points (5, 25) and (6, 36) the line chart will
show a discontinuity as expected. On the other hand if we define a consolidated list with x values going
16 | P a g e

from 1 to 10 in steps of 1 as shown below and corresponding y values (square of the x values) we would
get a plot that looks like the one shown below. Since the x, y data set in this case forms a consolidated
series, TK Solver will plot a smooth curve that joins adjacent points. You don’t see a discontinuity in this
case.

It is therefore important to note that Multiple X versus Multiple Y charts recognize each X, Y data pair as
a single line.
Extending our example further, let’s now change the data as shown below:
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Notice that we now have a consolidated list x1 that goes from 1 to 10 in steps of 1 and all we have done
is to modify list y2 by inserting 5 blank elements so as to maintain the correspondence between the
x[n]th element in the list x1 with the corresponding element in the list y2. If you now view this plot, it will
look exactly like the plot we started out with.
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When the sheet cursor is placed on the X Axis or Y Axis list elements in the line chart sub sheet, the
properties pane automatically shows the properties of the highlighted lists. If you want to access the line
chart properties move the cursor to any other column other than the X Axis or Y Axis columns.

Placing the cursor on a list name in the line chart sub sheet and pressing Ctrl+D opens the corresponding
list sub sheet. Alternately one can use the Display Sub sheet command from the Window menu
dropdown to open the sub sheet of the highlighted object.
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Sharing Calculations over the Web
About CalcEdge™ Wizard:
Solutions created using TK Solver 6.0 are posted to the CalcEdge™ cloud server using the
CalcEdge™ wizard provided with TK Solver 6.0. This section introduces authors to the
CalcEdge™ wizard and also provides tips that can make the solution creation process easier for
authors and a lot more compelling for end-users. This documentation assumes that you are
already familiar with TK Solver 6.0 and are comfortable creating models that meet your
calculation requirements.
The CalcEdge™ wizard offers all the facilities needed for posting and subsequently managing
the deployment of your calculations. You can bring up the CalcEdge™ wizard from the Wizards
tab of the TK Solver 6.0 main menu. A user who wants to post calculations to the CalcEdge™
server needs to register on the CalcEdge™ site. As described at the beginning of this document
you can register either through the CalcEdge™ portal or through the opening screen of the
CalcEdge™ wizard shown in Figure 1.1.
User login/password based authorization
Only registered users can be logged into the wizard. It requires valid email id as a user name.

Fig: 1.0
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New User registration
New users can register using the CalcEdge™ website or the CalcEdge™ wizard within TK Solver
6.0.

Fig: 1.1
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Once logged in, the wizard’s command pane on the left provides access to all the major
management functions described below.

Fig: 2
My Dashboard: contains the author’s calculation and CalcPacks in tree hierarchy. The
Dashboard tree further divided into three categories.
1. My Calculations - shows all author specific CalcPacks and Calculations.
2. My Subscriptions - shows all CalcPacks and Calculations subscribed by the author as an
end user.
3. My Library - authors can create a library of calculations. Drag and drop calculations from
the My Calculations or the My Subscriptions areas and drop them into the My Library
area. Right click on My Library to create folders if desired. When you are done you must
right-click on My Library and select “Save to database” to keep the changes. In the
browser version of CalcEdge you must click the Save button.
My Calculations: A listing of all calculations and its version(s) uploaded by the author to
CalcEdge™ cloud server.
The user interface consist of two panes, left pane shows listing of calculation and version(s) in
tree hierarchy, right pane shows additional information associated with the selected
calculation.
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Fig: 3
The selected calculation details showing in right pane are as follows:
 Description of calculation
 Associated icon
 Rating given by the other viewers
 Subscription type which can be changed at any time
 Subscribers count
 View count
 Uploaded date of calculation
 Published date of calculation
 Calculation view, a URL link specific to the calculation
 Custom view, a URL link specific to the calculation custom view (Mathlook created in TK
Solver 6.0)
 Standard view, a URL specific to the calculation standard view (A Tabbed view, having TK
like variable sheet, plots and tables in separate tab pages)
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Below the calculation details are the following buttons:
Subscribers – shows a listing of CalcEdge users who are subscribed to the calculation

Fig: 3.1
CalcPacks - This button functionality is yet not implemented. (But tentatively, it will show the
listing of all CalcPacks, having the selected calculation linked).
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Share - an author can share its own calculation with other user(s) as well.

Fig: 3.2
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Update - To update an existing calculation and calculation version, It also allow author to delete
the selected calculation or version (But the calculation shouldn’t subscribed by other user(s))

Fig: 3.3
My CalcPacks
Calculation Packs are a pre-organized and pre-packaged group of calculations that logically
belong together. The grouping and sub-grouping of calculations within a CalcPack is done by
the author prior to releasing the CalcPack. Calculations sold or shared by the author as packs
are inseparable and constitute a consolidated entity to be shared or sold as is. CalcPacks are
subscribed to end-users exactly the same way as individual calculations are. It therefore follows
that end-users cannot subscribe to individual calculations within a CalcPack, but would be
required to subscribe to a CalcPack in its entirety. The following image shows the CalcEdge™
wizard’s CalcPack management screen.
Using this user interface (Fig: 4) author can Add/Update/ Delete CalcPacks and post it to
CalcEdge™ cloud server.
To start the creation of new CalcPack, Just click on ‘New CalcPack’ button either or drag the
calculation(s) from ‘My Calculations’ tree view and drop it into ‘New CackPack’ tree view.
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Fig: 4
Post Calculation
Posting TK Solver 6.0 model to CalcEdge™ cloud server for sharing with other user under
different sharing modes (e.g. Private, Public and Protected). Make sure you have saved the
model before proceeding.
How to Post a calculation to CalcEdge™ cloud server
Click on ‘Post Calculation’ button on left side toolbar. There are two options for posting; 1)
Posting TK model as a new calculation and 2) Posting TK Model as a new calculation version:
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1) Posting TK model as a new calculation
Step-1: Select this option if you are posting completely new calculation.

Fig: 5
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Step-2: Click on Next>> button and provide valid name, description, version description and
tags (related search keywords).

Fig: 5.1

Fig: 5.2
Figure 5.2 shows how the data entered into the form shown in Figure 5.1 maps to the
infographic display in the browser window.
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There are four different options to control the look and feel of posted calculation on CalcEdge™
website.
a. Direct Solve: Enable/ Disable the solve button on Calculation page to CalcEdge website.
b. List Solve: Enable/Disable the List solve button on calculation page to CalcEdge website.
c. Instant Solve: Enable/Disable solving mode, Check the instant solve checkbox in order to
automatically trigger a Solve operation after each input is provided.
d. Custom View: Enable/Disable customized view (Mathlook), specific to the loaded TK Solver
model.
Icon - An icon that display with the specific calculation on CalcEdge™ website.
Click on icon to change the default icon of calculation that being posted.

Fig: 5.3
Using this Icon Palette window the author can browse his or her own calculation icons or pick
one from existing collection defined under different domains.
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Click “Check for icon updates…” to download the latest updates to the icon library. New icons
are regularly added to the CalcEdge™ cloud server to facilitate authors in different domains.
Upload - Click on ‘Upload’ button to post the calculation under ‘Unpublished’ mode.
Note: * Uploaded calculations that are Unpublished stay private by default and are not visible to
end-users or the CalcEdge™ search engine. Uploaded but unpublished calculations therefore
enable the author to test the calculation and its behavior on the server before actually publishing
them for end use.
Step-3: Publish or Release the calculation under different modes, before publishing the posted
model to CalcEdge™ cloud server the author should verify the look and feel of posted model on
CalcEdge™ website (by clicking on Calculation view link).

Fig: 5.4
The default Subscription Type is set to ‘Unpublished’. As mentioned earlier, the ‘Unpublished’
state keeps the calculation in private mode where it is only accessible (or visible) to the author.
It automatically means that such calculations will not appear in search results either. The
author however has the option to change the Subscription Type at a later stage if he or she
chooses to. Here is a screen short of the online explanation of each Subscription Type in the
wizard:
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NOTE:* Once a Calculation has at least one subscriber, the author cannot change the Subscription
Type of the calculation
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2) Posting TK Model as a new calculation version
Step-1: Select the ‘Create new calculation version’ option and click on next button

Fig: 5.5
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Step-2: Select the existing calculation and provide new calculation version description and
check the pre-checked option and click on Upload new Version button to post the new version.

Fig: 5.6
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Step-3: Now publish the version if not been published in previous version.

Fig: 5.7
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Subscription Request
Listing of all Incoming requests from other users to subscribe the author’s calculation.

Fig: 6
Author can accept or reject the request coming from other users.
Notifications
Not yet implemented. (All author specific notifications)
My Profile
Not yet implemented. (Authors user profile)
Logout
Log out currently logged in session of author.
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